
WRITING A PAPER WITH 
MA THWRITER™ 2.0 

A Primer 

Nancy B. Cooke 
Richard D. Cooke 

©1991 Cooke Publications, Ltd. 
Ithaca, New York 





Contents 

A brief introduction 2 

To start MathWriter 2 
Math Writer screen 3 

Screen sections 4 
TheCursor5 
TheMenus5 

Online Help 6 

Writing a paper 8 

Auto save 8 
Screen refresh 9 
Entering text 9 

Fonts 9 
Selecting a new font 10 
Changing font size 11 
Changing font style 11 

Aligning text 12 
Typing text 12 
Selecting or highlighting text 12 

Dragging the mouse 13 
Selecting a single word 13 
Selecting a single line 13 
Selecting a large block of text 13 
Selecting the entire file 13 

Undoing an operation 13 
Cutting and pasting text 14 
Copying text 15 
Clearing text 15 
Copy Other and Paste Other 15 
Show Selection 15 
Saving a document 15 
Save as ... and Save a Copy 16 
Printing 16 

Formatting a document 19 

Page Numbering 19 
Footnote/Endnotes 21 
Sizing margins 22 
Paragraph spacing 23 
Setting line spacing 24 

The ruler 25 
Hide ruler 25 
Inches or centimeters 25 
Paragraph margins 25 
Indentions 26 
Tabs 26 
Tab rubber band feature 27 
Setting tabs for a title page 27 

Inserting a page break 28 
Show and Hide 28 

A few extra features 29 

Style 1 and Style 2 29 
Find/Replace 30 
Checking spelling 31 
Word count32 
Line numbering 33 
Inserting graphics 34 
Sizing the graphic 34 
Moving the graphic up or down: 35 
Clean Up Windows 36 

Writing mathematical expressions 37 

Tools, Templates, and Palettes Windows 37 
Font Table Window 38 
Auto Math and Auto Math Options ... 39 
Diac 39 
Typing an equation 40 
Numbering an equation 42 
Equation reference numbers 43 
Correcting an error in a mathematical 

expression 43 
Creating a table 43 



2 Writing a Pa-per With Math Writer 

WRITING A PAPER WITH 
MATHWRITER™ 2.0 

A brief introduction 

To start Math Writer 

A Primer 

Nancy B. Cooke 
Richard D. Cooke 

MathWriter 2.0 is the first word processor that enables you to type equa
tions as easily as text. You can write and edit a document containing equa
tions without pasting or moving back and forth between various programs or 
windows. While this feature is particularly relevant to the scientist, other 
features of the program are quite useful to anyone. 

This manual is designed to help you learn, in as little time as possible, 
certain basic features of Math Writer that apply to writing a paper, one 
that includes mathematical expressions. It is not intended as an exhaustive 
explanation of all of the features of the program. It assumes that you have 
some experience working with a Macintosh. If not, please refer to the user's 
manual that came with your computer for basic instruction in how to use the 
Macintosh. If you have previously used a program like WriteNow, you 
should have no difficulty. Many of you will be able to take the examples in 
this manual and extrapolate to other features of the program. 

1. Complete the usual Macintosh start-up process. 

2. Double click the MathWriter icon. This brings up the following 
MathWriter screen. 
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Math Writer screen 

s File Edit Formot Polettes Oioc Style Windows 

Base 

untitled 1 
2 3 

L1,CO 

5 

i~I 
1111 

Notice that the screen looks very much like that of a standard Macintosh 
word processor. Now look at a picture of the screen with many of the parts 
labeled. 
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Screen sections 

Bue 

Base 

Menu bar 

Close box 

Horizontal 
scroll bar 

First line paragraph indent 

Paragraph margin markers 

Title bar 

Ruler 

Header 

Insertion point 

Ruler marker 

Status bar 

Header 

Status bar 

Cursor 
location box 

Paragraph/ 

alignment i!'.l!i 

Venical 
scroll bar 

Gtneva 12 

Font, font size, and 
font style 

Shows the MathWriter menus. 

Closes the window. 

Indents first line of each paragraph. 

Indicate the left and right margins of text 

Shows the file name, "untitled 1 ". 

Shows tabs and paragraph indentions. 

Shows the space where you type headers. 

Shows point of text entry. 

Indicates ruler changes. Each time you press 
return, you create a new paragraph that 
inherits the ruler of the preceding 
paragraph unless you create a new ruler. 

Contains Base, Scroll bar, Cursor location 
box, and Font at insertion point. 



The Cursor 

The Menus 

Base 

Horizontal scroll bar 

Cursor Location Box 

Font, font size, font style 

Vertical scroll bar 

Paragraph alignment 

Tab well 
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Tells the position of the insertion point 
within a built-up mathematical 
expression. 

Scrolls text horizontally. 

Tells the line and character position of the 
blinking insertion point. 

Identifies font, font size, and font style. 

Scrolls text vertically. 

Aligns paragraphs flush with left or right 
margins, centers paragraphs, or aligns 
them flush with both margins. 

Supplies a left align.-, right align 4, center 
align •, and decimal align 0 tab. 

Math Writer has a variety of cursors, only two of which are discussed here. 
Below are the two insertion point cursors. 

I-beam .... rn ................................ . Enters text. 

Split I-beam .. [J ......................... . Edits mathematical expressions. 

Since Math Writer lets you edit the header, footer, and footnote regions of a 
document without opening a separate window, you need to be able to tell 
when you have left the main body of text and entered one of these regions. 
Below are the cursors that change to identify each region as you move from 
one to another. 

.... Q ...... ~ ... 

p: 
~ Body 

"~ Header 

"~ Footer 

"~ Footnote 

Below is an illustration of all of the rrenus in Math Writer. They provide 
many different options, but in this manual we refer only to those commands 
in each menu that you would need to write a simple paper containing simple 
mathematical symbols. Those shown dimmed are not available in the 
Educational Version of MathWriter. 
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. 
Geometry 
Operators 
Math/Calculus 
Sets 
Logic 
Rrrows 
Misc. 
Brackets 
U11r111bles 

Online Help 

mm 
New • Undo Typing xz 
Open ••. XO ---------~-

Close xw Cut XH 
Sllue XS Copy •c 
Saue RI .•• P11te Picture •u 
S11u11 11 Copy ••• Clear 
Import lirephlu Fiie ••• Select Rll XH 

Copy Other • Pr.rerences ••• Put• Other • Show Selection 
Doc Info ••• lleulse \plt•cll<111 .,., 
Page Layout ••• UnllPulse \PIPclion 
Doc Layout"" 
Doc PrererencH •• , Find/Replace KF 

Find NeHt Xii 
Dut•rulew ••• Replace Selection KH 
Print". XT 

Check Spelllng ... 
Quit XO .... 

~ L .!. I 0 0 ~LI DD 00• ; .. 
+ - )( . - . " s ~ "' :I: • I I 
I n I I /!. 9 11!:1 . ... .. .. . 

; 

u " :> c ;;ii;; a • • Im !) 0 

• • ., .·. ·: v 3 J ....... t J. H- I.,. ""' R II ""' j Raise XR 
t :I 11=> II c • t f . £ ~ I ' .. Lower •l 
( ) I I ( I L J r i I ) 

rr . m11m(!) , • ':= 
'• I• ,X !ti ( )e n '1i I! 

llemoue 
uml.11.11ercl•rHili 

, .. 1u1 11htr1nntt•l 

. , •r. •-
Hide Ruler 
Ruler Options 

Paragraph Format ••• 
Line Spacing .•. 
M11tr1H Format ••• 
U11r111bles Format ... 

lnset1 Memo 
lnse11 Column llroak 
Insert Page Break 

Cale Preu I or I Size 

Hide Layout 
Hide MUlllQH 
Show lnulslblu 
Hide Pictures 

• TeHt SIZH • TeHt Style • liraak x 
Larger Size X+ 
Smeller Size x-
Style I •< 
Style 2 •> 
lHt style X\ 

Rulo Meth KE 
Rulo Math Options ... 
ltolic~ CH<Pptlons list ... 

MPtrlu ••. 

User St las ... 

If, as you proceed, you need more information: 

•• • ... 
KK 

•D 

.. 
Clean Up Windows 

---
Tools Window XI!. 
Tools • 

,;'Templales Window 
Pelettu Window 
Font Table Window 

1--------· 
1 lhrory ll•lndou• 
llbro1·y • 
Moduln • 
~ 

Cllpboerd 
Help •1 

,;'untitled I 

1. Pull down the Windows menu to Help and release the mouse. That opens 
the following window. 
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~~~··'······ 1-~~.!.!1.!.'.l'f:"«.c;~,~~~...:;.~;!l;"!::~~.~':?:•··.·~-·~~-''!t•_"l•_•t•~:...:.:..:.::..·'IJ 

Cus1omiu1ion/D•f•ul1s 
Confi9ur .1tion 
Document 
File Typu 
Librar\j 

Dat•/Timt 
Editin9 Tools 

Char •ettr Editor 
Cut/Copy /Paste 
Find/Repl•ct 
Hyphtn.1tion 
Input Tools 
Math Editor 
Ovtrvitw 
Rev1s1ons 

Tracking 
Lint Numbers 

[ Help II 

Select help by double-c11ck1ng 
tn ci topic; or click in Help for 
the currently selected top1c. 

2. Scroll in the vertical scroll box to find the topic you want. 

3. Double-click on that topic or click en a topic and then click the Help 
button to receive information about the topic. That changes the button 

II. Help JI to Ii. Topics ~and provides two sets of arrows ( « J ( » J for 

paging. 

4. Click on the arrows to scroll the pages in the information window. 

5. Click Topics to return to the original list of Help topics. 

6. Click the tiny, square box in the upper left comer of the window to close 
the window. 
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Writing a paper 

Auto save 

Styles: 

r 

We place Auto save first because we strongly recommend that you save your 
work at intervals in the event of a power failure or some other unforeseen 
accident. If you tend to forget to save your work often, this command lets 
MathWriter assume that task for you. We discus.s the regular saving 
procedure later. 

1. Pull down the File menu to Doc Preferences ... and release the mouse. This 
opens the Document Preferences ... window. 

Style 1 

Document Preferences ... 

C8:1 Au t 0 s 8 u e 1¢ FO:i!U/Hrnmrnn OJ 5 
D Warn me before s~rnlng 

D Auto backup during nues 

minutes 

C8:I Compact file C8:I Smert quotes 

l H-..:: R D B•~uision 11'<1< kinq Cl<rnrn1i1 

'--~--Style 2 I D Fractional character widths 

Footnote/Endnote I D Line numbers 
0 Jl(ff JHl90 

' flu1 o - itulic~ st Bl<~ ·1 @ 1:on1irn1ou~ I, C:ancel 1 (f: OK I. ______ _ 

2. Click in the box beside Auto save. 

3. Scroll in the scroll box to the right of Auto save to set the time intervals 
at which you want Math Writer to save your document. 

4. Click in the box beside Warn me before saving if you want Math Writer to 
give you a warning before it saves your document. 

5. Click in the box beside Auto backup during saves if you want Math Wri ter 
to make a backup of your current file in addition to saving the current fi le. 
This saves the two most recent copies of your file. 

6. Click OK to accept your choices or Cancel to reject them. 
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Entering text 

Fonts 
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If at any time while you are typing, the screen does not clean up as you want 
and you need to redraw it, press# option Z. 

Let's assume your assignment is to write a twenty page paper about Ithaca, 
the title of which is "Ithaca, New York." 

Math Writer offers a variety of fonts, font sizes, and font styles. These are 
located oo the Style rrenu and are easily changed. However, we strongly 
recommend that you choose the font for your paper before you type the 
paper, rather than afterwards. Fonts vary in size and in the amount of 
space they require; changing fonts after you type the paper can change the 
spacing you have set up. The default font is Geneva, the size is 12 point, and 
the style is Plain. These appear checked on the following Style submenus. 

Auont Gorde 
Bookman 
Chicego 
Courier 

..t'Geneua 
Heluetico 
Monaco 
N Heluetico Norrow 
New Century Schlbk 
Polatino 
Iymbol 
Times 
Zorif Chancery 
l.!lJ:!f Dingbots 

TeHt Sizes 
TeHt Style 
Greek x 
Lorger Size X+ 
Smaller Size x-
Style 1 X< 
Style 2 X> 
Lost Style X\ 

Auto Math XE 
Auto Moth Options ... 
I tnlic~ I: ll< •~I> tions l.is1 , .. 
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Selecting a new font 

TeHt Fonts 
~tmtj 

6 point 
7 
8 
g) 

nm 
.tn~ 

nl(} 
nm 
~I(} 
36 
48 
Other (64) ... 

Greek 
Lnrger Size 
Smaller Size 
Style 1 
Style 2 
L8st Style 

TeHt Style 
Greek 
LHrger Size X+ 
Smaller Size X-
Style 1 X< 
Style 2 X> 
Lest Style H\ 

Auto MHth 
Auto MHth Options ... 
I tnlic~ (B< •~P tions Us1 ... 

.tPIHin XP 
x Bold KB 
X + /lo/ic :1€1 
x- Underline XU 
X< OOrnQO~rn@ 
X> "Ul~ (il(i)[g 
:1€\ Condense 

[Ht end 
Auto MHth XE Other Styles ... 

.....-~~~--~~~--" 
XY 

Auto Math Options... I 

1. Type, "Ithaca, New York". 

Now suppose you wanted to change the font of the title, make it bigger, and 
make it boldface. Use the following procedure to change the font in the 
title or any place in the document. 

1. Highlight the title by placing the cursor at the beginning or end of the 
text, holding the mouse button down, dragging the cursor across the text, and 
releasing the mouse or by clicking the mouse three times in the line of text 
to highlight the entire line. Warning: If you highlight text and press 
return, the highlighted text disappears. 

2. With text still selected, pull down the Style menu to Text Fonts, drag to 
N. Helvetica Narrow in the pop-out window, and release the mouse. The 
title should read: 



Changing font size 

Changing font style 
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Ithaca, New York 

If you press the option key and then pull down the Style menu to Text Fonts, 
the font name appears in its own style to help you decide which font you 
want to use. Note that those fonts that appear underlined in the Text Fonts 
pop-out menu are built-in LaserWriter fonts. If you intend to print your 
document on a LaserWriter, we strongly rerommend that you use Laser
Writer fonts. 

1. With the title still highlighted, pull down the Style menu to Text Sizes, 
drag to 18 in the pop-out window, and release the mouse. The title should 
read: 

Ithaca, New York 
2. Pull down the Style menu to Larger Size and release the mouse. The font 
size increases to 24 point. 

3. Pull down the Style menu to Smaller Size and release the mouse. The font 
returns to 18 point. 

1. Pull down the Style menu again to Text Styles and select Bold on the pop
out menu. The title should read: 

Ithaca, New York 
2. To remove the bold attribute, with the title highlighted, click Bold 
again or click Plain. Plain removes any combination of selected style 
attributes. 

3. Click the mouse in the document outside the title to urdo the 
highlighting. 
4. To return to the original font, size, and style, pull down the Style menu to 
Text font and select Geneva, to Text Size and select 12, and to Text Style and 
select Plain. Notice the symbols on the Text Style pop-out menu after the 
words Plain, Bold, Italic, and Underline. They look like this: 3C P, 3C B, 3C 
I, and HU. These are keyboard equivalents for those four font styles, and 
you can use them to change the font style of a portion of text. To italicize 
the title of your paper using the keyboard rather than the mouse: 

1. Highlight the title. 
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Aligning text 

Typing text 

2. Press It I. Now your title should look like this: 

Ithaca, New York 

3. Press # P to change text to Plain. Later we will tell you how to use Style 1 
and Style 2 found on the Style menu. 

1. Highlight the title by pressing and dragging the mouse over the title. 

2. Click the E!J symbol in the Paragraph alignment box in the upper right 
corner of the screen to center the title. 

Ithaca, New York 

3. Click at the end of the title to undo the highlighting. 

4. Press return and click the ITB symbol in the paragraph alignment section 
of the screen to move the blinking insertion point to the left of the screen 
and begin typing the main body of text. The two other paragraph alignment 
symbols 8 and §j] align text on the right margin or on both margins 
simultaneously by adding spacing between words. 

1. Type the following two paragraphs from Morris Bishop's book, A 
History of Cornell (Bishop 1962, 1 ): 

"A contemplative traveler, journeying to Ithaca a century ago by the road 
along Fall Creek, might well pause at the hilltop above the valley ... 

"Northwestward he looks to Cayuga Lake, disappearing to the horizon, 
taking its color for the day, gray to flashing green-blue." 

2. Press the delete key if you make a mistake and want to delete a letter. 

3. If you want to add a character, place the blinking insertion point in the 
text where you want the character and type the character. 
4. Notice that MathWriter automatically indents the first line of each 
paragraph. When you reach the end of a line, it automatically moves the 
insertion point to the next line. You only press return when you want to start 
a new paragraph. If you want to remove the first line indent, place the 
cursor on the first line indent symbol .I. on the ruler, drag it to the 0 on the 
left end of the ruler, and release the mouse. 

Selecting or highlighting text 

This is very important because the cardinal rule of Macintosh is to select 
the portion of text you want to affect before giving a command. Math Writer 



Dragging the mouse 

Selecting a single word 

Selecting a single line 
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offers several ways of selecting or highlighting text. Selected text is white 
on black. 

1. Click with the mouse at the beginning of the last line of the text you 
typed, "taking its color for the day, gray to flashing green-blue." 

2. Press and hold the mouse button. 

3. Drag to the end of that line. 

4. Release the mouse button. The text is selected. 

+ Double click on the word "flashing." That selects the word. 

+ Triple click on the line "taking its color for the day, gray to flashing green
blue." That selects the entire line. 

Selecting a large block of text 

Selecting the entire file 

Undoing an operation 

1. Click at the beginning of the two paragraphs you typed about Ithaca. 

2. Hold down the shift key. 

3. Click at the end of the two paragraphs. That selects the entire portion of 
text between the two clicks. 

+ Pull down the Edit menu to Select All and release. That selects the entire 
file currently open on the screen. 

The Undo command oo the Edit Jre'lu in Ma th Writer applies to the 
immediate past command for most operations as well as to editing. Its name 
changes to identify the available operation. Be careful when you use it 
with the Replace All command in Find/Replace on the Edit irenu. In fact, 
any time you use Undo in a global fashion, we recommend that you save a 
copy of your text first. We will explain how to use Save a Copy on the File 
menu later. 
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Cutting and pasting text 

1. Highlight the word "flashing" in the last sentence of the text you typed. 

2. Press at I to italicize that word. 

3. Pull down the Edit rrenu to the first conunand which now reads Undo 
Style Change and dick on that command. The word "flashing" returns to 
plain text. 

The Cut command on the Edit rrenu cuts selected text from a document and 
places it on the Clipboard, a temporary storage location. 

1. Select the word "Northwestward." 

2. Pull down the Edit rrem to Cut and dick the rrouse on that command to 
remove the selected word from the paragraph and transfer it to the 
Clipboard. 

3. To view the Clipboard, pull down the Windows menu to Clipboard and 
release the mouse. A picture of the Clipboard containing the cut text 
appears on the screen as shown below. When you cut a second portion of text, 
the second portion will replace the first portion on the Clipboard. 

0 PIC T @TEHT 
Northwestw •rd 

4. Click the small box in the upper left comer of the Clipboard to close that 
window. 

5. Place the blinking insertion point between the words ''looks" and "to" in 
the sentence from which you cut the word "Northwestward." 

6. Pull down the Edit menu to Paste Text and release. 

After you capitalize the "h" in the word "He" and make the "n" in th e 
word "northwestward" lower case, your text should read: 

"A contemplative traveler, pumeying to Ithaca a century ago by the road 
along Fall Creek, might well pause at the hilltop above the valley. 

He looks northwestward to Cayuga Lake, disappearing to the horizon, 
taking its color for the day, gray to flashing green-blue." 
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Clearing text 
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+ Pull down the Edit IT6\U to Copy to place a copy of selected text on the 
Clipboard without removing it from the document. 

+ Pull down the Edit IT6\U to Clear to clear selected text from the document 
without saving a copy on the Clipboard. Cleared text is no longer accessible 
unless you pull down the Edit menu to Undo Oear as your next command. 

Copy Other and Paste Other 

Show Selection 

Saving a document 

+ Pull down the Edit IT6\U to Copy Other and Paste Other in order to copy 
and paste such things as a particular ruler or format. Pull down the Edit 
rrenu to Copy Other and select Copy as Picture to copy a mathematical 
expression as a picture in order to paste it into another application such as a 
layout program. 

+ Pull down the Edit menu to Show Selection, and Math Writer scrolls to the 
place in the document where the blinking insertion point is located. This is 
a short cut to return to the place you were editing after you have scrolled to 
another part of the document. 

To save a document 

1. Pull down the File Jrenu to Save. This opens a window similar to the 
fo11owing window: 
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Save as ... and Save a Copy 

Printing 

~MW Disk 

( Eject Disk ejector 

( Driue J - Driv• selector 

Soue 

File Type: MothWriter'"' 2.0 I --------1f+-Fil• type pop-up menu 

2. Type "Ithaca, NY" in the File name box to assign a name to your file. 
Names can include spaces, but not colons. 

3. Click Drive to select the drive and disk to which you want to save your 
file. 

4. Click on the Current folder name and pull down to open a pop-up rrenu 
that give you access to a hierarchy of folders where you click on the name 
of the folder in which you want to save your file. 

5. Click Save to accept your choices or Cancel to reject them. That saves 
your file under the name you have assigned it. Notice that the name of the 
file in the title bar at the top of the screen has now changed from "untitled 
1" to "Ithaca, NY.'' 

Save as ... on the File ITC'lu lets you save your file under a different name 
without changing the name of the current file and makes the new file the 
active one. Save a Copy ... you lets you make a copy of your file under a 
different name without making the new file the active one. 

Generally, we recommend that you select the type of printer, LaserWriter 
or ImageWriter, before you type a document. You may have to reformat the 
document if it is set up for one and you try to print it on the other. Select the 
printer by pulling down the 4* menu to Chooser and clicking LaserWriter or 
lmageWriter. Refer to your Macintosh manual if you do not know how to do 
this. 
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To reformat a document: 

+ Pull down the File mmu to Page Layout and click on Page Setup. You may 
need to scroll through your document to make sure reformatting did not 
change such things as tab spacing. 

To print a document: 

1. Pull down the File menu to Print and release the mouse. This opens one of 
the following windows. First, let's discuss the LaserWriter window. 

LoserWriter 

Coples:lmll 

Couer Page: 

"LoserWriter 11 NT" 5.2 n OK B 
Pages:@ All O From: D To: D ( Cancel ) 

@ No O First Page O Last Page [ Help ) 

Paper Source:@ Poper Cossette O Manual Feed 

D Page Range Refers To Page Uorioble Numbers 

Print Markers For: 

DMemos D D Ruler Changes C!TJ D Reuisions I 
Print Multiple Copies: ®Uncollated O Collated 

D Print Both Sides D Reuerse order 

Poper Motion Configuration: 
TRAY HAN. 

II 
TRAY 

~ 2"' "'Cl:' ...... . 
LW+ LW+ LWII 

HAN. HAN. 

ti ~ 
LWII LWU 

2. In the box beside Copies: type the number of copies you want to print. 

3. Notice that the button beside All is currently clicked, which means the 
printer will print the entire document. If you want to print only a few pages, 
click the button beside From: and type the page numrers you want in the 
rectangles beside From: and To:. To print a single page, supply the same 
page number in the From: and To: boxes. 

4. Click OK to accept your choices or Cancel if you do not want to print your 
document. 
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=lm==o=g=e=W=ri=t=e=r===============================v2==.7 € OK Il 
Quality: O Best @Faster O Draft 
Page Range: @All O From: D To: ..... I ___ I Cancel ) 

Coples: I• I 
Poper Feed: @Automatic 0 Hand Feed 

D Poge Range Refers To Poge Uoriable Numbers 

Print Morkers For: 

D Memos D D Ruler Changes~ D Reuisions I 
Print Multiple Copies: @Uncollated O Collated 

D Print Both Sides D Reuerse order 

1f you are printing with the ImageWriter: 

1. Choose the quality print you want, Best, Faster, or Draft. Best is slowest, 
and its dots most dense. Faster is like Best, but less dense. Draft is fastest, 
but loses the character formatting information. 

2. Notice that the button beside All is currently clicked, which means the 
printer will print the entire document. If you want to print only a few pages, 
click the button beside From: and type the page numbers you want in the 
rectangles beside From: and To:. 

3. Click OK to accept your choices or Cancel if you do not want to print your 
document. 
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Formatting a document 

Page Numbering 

You can place page numbers in the header or the footer. 

To format page numbering: 

1. Pull down the Format menu to Variables Format. .. and release the mouse. 
This opens the Variables Format window. Note that three dots after a 
command indicates that releasing the mouse on that command requires 
additional information to complete the command and opens another 
window in which you can supply that information. 

Uariables format. .. 
Uariable Style 

m creation date 0 

m current date 

1'00 creation time 

@ current time 

~ page# 

0 I, ii, iii 

0 I, II, Ill 

® 1, 2, 3 

~ # of pages in document 

r-- footnote/endnote leading teHt ~ 
trailing teHt ~ 1 11 re-reference footnote/endnote 0 

New 

eHample 

r Flcrnmnc~ 
starting at ~I t_l __ -J 

f Cancel I [ OK D 

2. Click the mouse on[!) page #J. Notice that the button beside the Arabic 
numerals 1, 2, 3 has already been selected. The Example box in the lower 
left portion of the window illustrates the way the numrer will appear in 
your text. You can choose Roman numerals instead if you want. 

3. Type "Page" followed by a space in the box beside Leading Text if you 
want the word ''Page" to precede the page number. 

4. Type "of " in the box beside Trailing Text if you want to print the total 
number of pages, for example, page 2 of 20. 
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5. Look at the Example box to verify that the page numbering looks the way 
you want. 

6. Notice that the Starting box contains the number 1. That means that page 
numbering will begin with the number 1. If you type "4" in that box, the 
first page of your paper will be numbered 4. 

7. Click OK to accept your choices or Cancel to reject them. 

To place page numbers in the document: 

1. Click in the Header of your paper on the screen where you want page 
numbers to appear in the Header. Click in the Footer if you want them in 
the Footer. The Ruler now applies to the header and can be used to format 
the header just as you used it in the body of the document. Warning: If the 
blinking insertion point is not in the Header or Footer of your paper, the 
page number symbol on the Palettes menu will be dimmed and unresponsive. 

2. Pull down the Palettes rrenu to Variables, drag to the [@]symbol, and 
release the mouse. Notice that the name ''Page **" appears in the bottom 
row of the Palettes window when you drag to the page number symbol. 
When you release the mouse, "Page 1 of" appears in the Header at the 
position of the blinking insertion point. Place the# of page in document icon 
~ from the Palettes menu after "Page 1 of." Now Math Writer numbers the 
pages of your document, keeping track of the total number of pages. 

To skip the first page and begin page numbering on the second page: 

1. Pull down the File rrenu to Doc Layout .... That opens the following 
window. 
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LByout of heBders, footers, Bnd footnote/endnotes .•• 
·····················································-····-·····-----···········--·---··----·----

Ev1ry p.aoe 

Skip first p.age 

Skip lut page 

~~=-=1=~~ ~~=1=~~ = }::. ~~0= Skip first & lut p.anes :-0::. ~~~ 
--- --- --- --- 11' --- --- --- ------· -·-· ·-·· ··-- ·-· ·--· ---- ·---

First page different 

I 111-·-1-·-~ :7~==~-;= ---· ·--- ---· ··--! ~~~ ::-:.~--= =-=~ ::-:.~--= 

·······································································································································-·········································································· 

Footnotes Endnotes er I DkJ~ 
sp;ice before sp;ice between 

2. Click on the set of pictures illustrating headers, the ones beside the 
words "Skip first page." 

3. Click OK to accept your choice, and the window disappears. Notice that 
the header on the first page of your paper is gone; but when you type to 
page two, the header will say, "Page 2 of 2." 

Math Writer gives you an easy way to insert footnotes, reserves space for 
them, and keeps track of the numbering for you. To create a footnote or 
endnote at the end of the two paragraphs about Ithaca: 

1. Place the blinking insertion point at the end of the serond paragraph 
after the period after the word "green-blue." 

2. Pull down the Palettes menu to the bottom row and click on the footnote 
icon~· This places the number 1 in your text at the insertion point and 
creates a footnote region also containing a number 1 at the bottom of the 
current page of your document. You can move the cursor into the footnote 
region and from the footnote region back into the document in two ways, by 
scrolling or by using the cursor location box. Let's try the latter first. 
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Sizing margins 

3. Oick on the cursor location box 

in the status bar at the bottom of the screen. The following pop-up menu 
appears. 

~Body 
~ Hudtr - Evtry Pill• 
l:!i F oottr - Ev try pigt 
~ Footnott 1 
~n.J.:~ 

4. Drag to Footnote 1 to move the blinking insertion point into the footnote 
region and to the right of the number 1. 

5. Type the footnote contents, "Morris Bishop. A History of Cornell. 
(Ithaca, New York, 1962), 1." 

6. Click again on the cursor location box in the status bar to open the pop-up 
menu and drag to Body to return to the body of your document. You can scroll 
from the body of text to the footnote and vice versa if you do not want to use 
the cursor location box, but using the cursor location box is more efficient. 
Notice that you can enter and modify text directly in the footnote. The 
cursor icon changes when you cross the boundary between the footnote and 
the body of the document. 

With Math Writer you can change the margins and the header and footer 
height. 

Pull down the File menu to Page Layout and release. This opens the Page 
Layout ... window. 
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Page Layout .•• Columns ® I 0 2: 0 ;j 0 .. J 
-.•>+•H•--•-•oooo--•·--·--·-··-··•-ooo•ooo __________ OOO•H--• -•••--• ••r•·•-.000000000--0•0_. ... ,,,,,, ,,..._, , ,,,,_,_,,,, , _,,,,_, __ , , .. ,_.,,, ,,,._. __ , ,, ,,,,. ,,,,,, 

Margins: 
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right 
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I 

I 
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: 

i 
I 
I P•9e '<fidth : 6 .00 in . P•ge hti9ht : 10.1 in . 

I 
D Facing pages 

I 
I 
I 
! 

Cancel OK J) 

2. Locate the word "Margins:" and in the box beside the word '1eft" change 
1.250 to 2.250 without disturbing the abbreviation for inch. Notice the 
change in the size of the left margin in the illustration of a page at the 
right. 

3. Change 0.500 to 1.500 in the box beside Header height. 

4. Click OK to accept your changes or Cancel to reject them. 

You can set the spacing between paragraphs and avoid having to press 
return several times to get the desired space between paragraphs. 

1. Pull down the Format JTC'IU to Paragraph Format. .. and release the 
mouse. That opens the following window. 
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Setting line spacing 

Pnn~grnph form8t ... 

-·-··-···-···-·-.. ·-··-- Sp o c in g ·-·----··------1···-------- Attributes ·------·-·-· 
I D Link to neHt 'II 

Before CU O i D Column breolc before 
After 'II o i D Poge brenlc before I D Can't split ouer page break 

.................. .................. Borders ·-.. ----··-······························· ········ .. ··························· ·· .. ···········-----·--······················· 

w hi t esp ace k'J I!=! mumnrni!!Ji!il!!ml 6 

Click abovt for thickntss and patttrn 
I Cancel I K OK J 

2. Scroll the two horizontal scroll bars following the words "Before" and 
"After" to set the spacing between paragraphs in pixel units. You can later 
adjust spacing between paragraphs quickly and easily by selecting the 
paragraphs and adjusting the value here. 

Because equations in a line of text demand sophisticated variations in the 
spacing between lines, Math Writer offers a variety of line spacings. 

1. Pull down the Format 11U1U to Line Spacing and release the mouse. This 
opens the Line spacing ... window. 

Line spncing ••• 

O AutomBtic 

@ Mostly fiHed 
0 Fhced 

! 
............................................................... , 
l .. ~~~~~! ...... ~~--~!.~~.s. .(.!.~~-~?. ...... ! 
r1·:-;-,.2··-<4··1i~·;;· ;-i~-~h»--··1 
, .... -........... -........................................... : 
i--········· · ······· ·--·······-·-···---········-·~ 
l Double (3 liMslinch) l "'-·-··•• 00••·······-.................. ,_,,, .. ,_, ......... 1 

Fix•d asctnt 

Fixtd dtSctnt + lnding 

·Simple··text·li.ne····1·2.4····nt)· ··········· .: ... .. : .............. : .... :: ... ::::: .. :: ... : ...... : .. :::: .............. : ... :::::\ ..... :::: .. :::~r: ... : ... ::::::: ... .. 

-·-· ······ -·-·-······-·· ··········------··~·-·--(-=.-1-5~f+-·r·- ···-· · · 

.Qom>J<x.mAlh.llxi< .... -;>-:..-.-.... -........ _ ...... --·---·-· 
k= 1 ln(.k+ 1) 

....... _..., ..... _,_,,, .... _,_,., .. , .... _ ...................... __ ,,, ................ _._, ..... ,_ .. , ................... . 

Display•d tquation adjustm•nt 

( C8n eel ) fi~( __ o __ K~ll 



The ruler 

Hide ruler 

Inches or centimeters 

Paragraph margins 
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2. Click the button beside Automatic, and MathWriter automatically 
adjusts the line spacing to accommodate the nonuniform height of 
mathematical equations. That means that the space between lines will 
become as large as necessary to accommodate an inline mathematical 
expression such as a fraction. We suggest that you use Automatic when you 
are writing mathematics. If you click Fixed, the program assures constant 
line spacing even if some characters extend into the space between the lines. 
Notice that the Single, 1-1/2, Double options become available when you 
click Mostly fixed or Fixed. 

3. Click Single for a single-spaced document, 1-1/2 for one-and-one-half
spaced, and Double for double-spaced. 

4. Click OK to accept your choices or Cancel to reject them. 

Math Writer is organized on the basis of paragraphs. Each time you press 
return you create a new paragraph. When you press return to create a new 
paragraph, Math Writer copies the current ruler, unchanged, to the new 
paragraph as the default ruler. If you want to change the formatting of a 
paragraph, place the insertion point within that paragraph to select it 
and make the changes you want on the ruler that appears at the top of your 
document. 

• Pull down the Format rrenu to Hide Ruler and release the mouse if you do 
not want the ruler to be visible on the screen. Oick on Show Ruler, row 
replacing Hide Ruler, to make the ruler visible again. 

untitled I 
11. 12. I I I I I 13. I I 14. 

To change the ruler units from inches to centimeters: 

1. Pull down the Format menu to Ruler Options. 

2. Drag to Centimeters on the pop-out menu and release. 

11. 12, • I • I 13, I , I . I 14, 

Is. 

Is. 
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Indentions 

Tabs 

To change the margins of a paragraph: 

1. Drag the paragraph margin markers • m the ruler to the desired 
position and release them. 

2. Drag them back to their original positions, 0 and 6, to return to the 
original margins. 

The ruler contains a first line indent marker• that automatically indents 
the first line of each paragraph. 

1. Click on the first line indent marker and drag it to the number 1 on the 
ruler. 

2. Type two full lines of text. Notice that the first line is indented one inch. 

3. Press return and drag the first line indent marker to the 1 /2 inch point on 
the ruler. The next line is indented 1/2 inch. 

11. I I I I I I 12. I I I I I I 13. I I I I I 
• ~ • 0 

Four types of tabs are available to align text horizontally - left align •, 
right align 4, center align•, and decimal align 0. 

1. Drag the right align tab 4 from the tab well in the upper right comer of 
the screen to the three inch mark on the ruler, release it, and press return. 

2. Press the tab key and begin typing. Text advances to the left keeping the 
right end anchored. 

3. Drag the right align tab back to the tab well and release it to remove it 
from the ruler. The left align tab works the same way, but anchors text on 
the left. 

4. Drag the center align tab • to the three inch mark m the ruler and 
release it. 

5. Assuming the insertion point is to the left of the tab, press the tab key 
and begin typing. Text advances to the left and right, keeping the center 
anchored on the tab. 

6. Place a decimal tab 0 on the ruler at the three inch mark. 



Tab rubber band feature 

Setting tabs for a title page 
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7. Press the tab key. 

8. Type the equation "x = 546.3." Notice that the decimal point stays at the 
three inch point on the ruler. 

Math Writer tabs have a rubber band feature that lets you align them 
exactly where you want them relative to the text. 

1. Drag a tab from the Tab well into your text. 

2. Release the rrouse button and watch the tab pop up into the ruler. To 
remove a tab from the ruler, you must drag it off the right end of the ruler 
because of the existence of the rubber band feature. 

1. Type the title of your paper, "Ithaca, NY," highlight it, and click 
Center aligned E!I in the paragraph alignment box. 

2. Press return and click Left aligned ~ in the paragraph alignment box. 
Then let's assume you want to put your name, the date, and the name of the 
class in the lower right comer. 

Title 

Name 
Date 
Class 

3. Drag a left align ._ tab from the tab well and position it at the four and a 
half mark on the ruler. 

4. Press return until you have reached the vertical location you want to type 
your name. 

5. Press tab and type your name. 

6. Press return, press tab, and then type the date. 

7. Press return, press tab, and then type the class. That should complete the 
title page. 



28 Writing a Paper With Math Writer 

Inserting a page break 

Show and Hide 

• Place the blinking insertion point immediately before the first line of the 
paragraph you want at the top of the next page and pull down the Format 
rrelU to Insert Page Break. That forces text to move to the next page. To 
remove a page break, you must place the blinking insertion point at the 
beginning of the first word on the second page and press delete. 

The last four items on the Format menu toggle between Show and Hide. 

1. Select Show Layout to reveal the boundaries of the headers, footers, and 
margins. 

2. Select Show Messages to display the markers for such things as the 
changes in paragraph rulers. Those markers appear on the left of the 
screen. 

3. Select Show Invisibles to see the hidden formatting characters like tabs, 
paragraph breaks, and page breaks. 

4. Select Hide Layout, Hide Messages, and Hide Invisibles to hide each of 
these. 

5. Select Hide Pictures to hide the pictures you have pasted in the 
document and, consequently, to scroll through the document faster. Show 
Pictures is the usual way to set this command. 
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A few extra features 

Style 1 and Style 2 

Let's suppose you have to type several quotes in your text and want them to 
appear in 9 point, italic, Helvetica font with both margins justified. 

1. Pull down the File menu to Doc Preferences ... and release the mouse 
button. That opens the Document Preferences ... window. 

2. Click on Style 1. That opens the following window. 

Set style number 1 ... 

C8:l Font I Auant Garde I 
C8J Size [!]] 181 Justification I Align I 

181 Style (Select style ... 1 181 Line spacing I Select spocing ... j 

S~1-ft:'! IXl1Jl.1d'" I wl LJ'.}C.1et7" .IA~ IY:f. .tr.1lli..-:i.7Ji..~J • .;.. IJe 
.1'"1!.)l.--:i}!7 L71:. L7fK:!t...~ai. 

I Cancel I 

n OK II 

3. Gick in the box beside Font if it does not already contain an x and press on 
the font name to its right, currently Avant Garde, to open a pop-up menu 
where you drag to choose Helvetica. 

4. Oick the box beside Size if it does not already contain an x and click on 
the nwnber to its right, currently 10, to open a pop-up m:nu where you 
choose 9. 

5. Click the box beside Style if it docs not already contain an x and click on 
Select style to open a pop-up menu where you choose Italic. 

6. Click the box beside Justification if it does not already contain an x and 
press the box beside it to open a pop-up menu where you choose Align. 
Notice that an illustration of your choices appears in the rectangular box in 
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Find/Replace 

the window. The text on the screen will be clearer when printed. 

7. Click OK to accept your choices or Cancel to reject them. 

8. Click OK to close the Document Preferences ... window. 

9. Pull down the Style menu to Style 1 and release the mouse. 

That chooses Style 1, and text that you type should appear in nine point, Helvetica, 
italic style with both margins justified, just like this text. Some words in this paragraph 
should have additional spaces inserted between them in order to justify both margins. 

10. Pull down the Style rrmu to Last Style to return to the text style you 
were using previously. This feature saves time by letting you access two 
styles that you use often. 

Find/Replace locates a string of text, a word, hidden formatting characters 
such as the end-of-paragraph symbol, or a tab marker. A search can even 
ignore the text and locate a particular font, size, or style. Finally, you can 
search in two directions from the blinking cursor, forward or backward. 
Let's search backward from the second paragraph of Morris Bishop's text. 

1. Place the blinking insertion point at the beginning of the serond 
paragraph, just before the word "Northwestward." 

2. Pull down the Edit IlU'\U to Find/Replace. That opens the Find/Replace 
window below. 

Find/Replace 

Match Affect Wildcards Special Dime. ti on 
.. 

Find: journeying 
Te Ht 

Replace with: 
I TeHt I 

Find XG (Replace, then Find) 

./ ['!J Forward 

[!J Backward 

~ Wrap around 

(Replace XH) (Replace All) 

3. Press on the word "Direction" and drag to Backward on the pull-down 
menu that appears. 

4. Type the word "journeying" in the Find dialog box where the blinking 
insertion point is now located. 
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Let's assume that you want to replace the word "journeying'' with the word 
"traveling." 

5. Click in the dialog box beside Replace with: and type the word 
"traveling'' in your document. 

6. Click the Find button at the bottom of the window to initiate a search 
backward for the word "journeying." Math Writer finds the word 
"journeying" and highlights it. 

7. Click the Replace button at the bottom of the screen. The program 
replaces "journeying'' with "traveling". 

8. To remove the Find/Replace window, click the small white box, the "Go 
away box," in the upper left corner of the window. 

To search for misspelled words: 

1. Place the blinking insertion point at the beginning of the Morris Bishop 
paragraph. 

2. Pull down the Edit rrenu to Check Spelling. The following window 
appears: 

i§O Spell Finder® from Microlyticsn• 

(Main Dictionary:) MathWriter Dictionary 

( User Dictionary: ) MW User Dictionary 

Status: Misspelled word 

...... I c_e_yu_g_e __________ ___.'l 1811 Alternates I 2 

( < Edit ) 

181 Skip words in All Cnps 181 Check for repented words 

3. Click the Check button at the bottom of the screen, and the program 
checks the spelling of your text, stopping on the word "Cayuga" which is 
not in its dictionary. In the dialog box beside Change to, notice that 
Math Writer has placed the word "Keg" which it supposes is what you 
meant to write. 
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Word count 

4. Click on the Alternates box for a list of other possible alternates. 

5. Click the Learn button if you want to add Cayuga to the list of correctly 
spelled words. 

6. If you want to delete that word from the list, click Edit to open the 
following window, in which you can edit the User Dictionary. The word 
"Cayuga" should row appear in that list. Highlight the word "Cayuga" 
and click Delete Word. 

Edit User Diction1uy .•• 

Biomechonics 
blophyslcol 
colcuhttionol 
dimensionolity 
Disk:ManagerPC 
dH 

I Delete Word ) 

Endogenous 
EPSF 

K OK J) 

7. Click OK to return to the Check Spelling window. 

8. If you do not want the program to learn the word "Cayuga," click Skip. 

Notice that the boxes beside Skip words in All Caps and Check for 
repeated words are checked. Math Writer automatically skips words that 
are in all capitals and checks for words you might have inadvertently 
typed twice. Click in the boxes beside Skip words in All Caps and Check for 
repeated words if you want to remove those options for this document. 

9. Click Cancel to return to your document. 

To find out the number of words in your paper: 

1. Pull down the File menu to Doc Info .... This opens the following window. 
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...... ,11 ..... , I 
Stssions : '-,-3------------------------J 

Crution dit•: 02/1 9 /90. 6 :04 :36 PM 
Modificition dit•: 09 /06 /90. 10: 1 9 :39 AM 

Stz:• on disk: 19 ,69:5 bytes (19K) 

P19ts : 3 Chirict•r~ 
Pirigriphs : 29 on bu• lin• : 3827 

Lints : 84 in sub-•xprtssions : 435 
"w'ords : 735 conhining sub-•xpr.ssions : 22 

M•mos: 0 Tobi: 4262 

Uniqu• rulers : 6 

I J Unique st1,1les: 14 OK 
St111e runs: 108 

Near the middle of the page appears the n~ of pages, paragraphs, 
lines, and words. You can see the other information available in this 
window. 

2. Click OK to close the Doc Info ... window. 

Writing and editing is sometimes easier if the lines of text are numbered. To 
number text lines: 

1. Pull down the File menu to Doc Preferences ... and release the mouse. This 
opens the Document Preferences ... window below: 



34 Writing a Paper With Math Writer 

Inserting graphics 

Sizing the graphic 

Document Preferences ... 

Styles: 181 Auto seue l<~i!HI w:w:mrnmrnnlc;>I 5 minutes 

fl<wi~ion s1~JI<~~ D Wern me before seuing 
D Auto beckup during saues 

Style 1 

Style 2 

Footnote/Endnote 

flu 1 o-· itn I ic~ s 1 ~JI<~ 

181 Compect file 181 Smert quotes 

x""'I; R D Bt~uision 11'<1< l<in•.1 f Cl<WrlllJI 

D Frnctionel cherncter widths 

D Line numbers 

Q Jl<~r Jl <ISJ<~ 
@ cont inuou~ I. Cencel I (I_ OK JI 

2. Gick in the box beside Line numbers. 

3. Click the button beside per page if you want numbering to begin anew 
with each page or the button beside continuous if you want numbering to be 
continuous throughout. 

4. Click OK to accept your choices or Cancel to reject them. 

With Math Writer you can insert graphics into your text or onto the 
Clipboard. However, unless you know how to put a graphic in the 
Scrapbook, just skip this section on graphics. 

1. Place the blinking insertion point in your document where you want the 
graphic to appear. 

2. Open the Scrapbook and select a graphic. 

3. Pull down the Edit menu to Copy and release the mouse to place a copy of 
the graphic on the Clipboard. 

4. Pull down the Edit rrenu to Paste Picture and release the mouse. This 
pastes the graphic in your document at the insertion point. 

To scale the graphic by menu: 
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1. Oick on the arrow tool ~Jin the Tools window. 

2. Pull down the Edit rrenu to Scale Picture... . This opens the following 
window. 

Scale picture ... 

@ Proportional scale lllinMl 3 

O Non-proportional scale 

( Set Full Size ( Cancel ) K OK n 

3. Click Proportional scale and type the percent you want the graphic 
increased or reduced in size relative to its original size. If it is already 
100%, it cannot grow larger. 

4. Click OK to accept your choices. 

5. Click the I-beam cursor in the Tools window to return to the text editor. 

To scale the graphic by mouse: 

1. Click the arrow cursor ~ in the Tools window. This places a frame 
around the graphic with small boxes in the corners. 

2. Place the arrow cursor in one of the small boxes, press the option key, and 
drag the box to change the size of the graphic without disturbing the width 
to height ratio. 

3. Click the I-beam cursor in the Tools window to return to the text editor. 

Moving the graphic up or down: 

1. Click the arrow cursor~ in the Tools window to select the character 
editor. 

2. Click on the graphic and release. This places a frame around the 
graphic. 

3. Place the arrow cursor in the frame and drag the graphic up or down. 

4. Click the I-beam cursor in the Tools window to return to the text editor. 
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Clean Up Windows 

+ If you have several windows open at once, pull down the Window rrelu to 
Clean Up Windows and release the mouse to "stack" the window with a 
slight offset. This lets you easily click the one you want and bring it to the 
front of the screen. You can select a document to become the active window 
by clicking on an exposed portion of the window. You can also pull down the 
Windows rrelu and select a file if its name appears at the end of the 
Windows menu. 
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Writing mathematical expressions 

Tools, Templates, and Palettes Windows 

• n • 
• I: • 

.r: 
u • 
f • 
{: 
[:] 

Math Writer provides three windows that are important in writing 
mathematics, the Tools window, the Templates window, and the Palettes 
window. They are called floating windows because you can place them on 
the screen where you want them while your document window is open. To 
position these windows: 

+ Pull down the Windows menu to Tools window and release the mouse. This 
places the Tools window in the upper right comer of the screen. On the same 
1re1u and in the same way, choose Templates window and Palettes 
window. This places these two additional windows on the screen on the left 
side and across the bottom. Your screen should look like this: 

m.~~~~~~~~~-:-:-=---~-.-~-::-~~~~~~ L!J Bas• LI , CO G•n•v~ 12 "CJ 

I A B r N s o n P I T v ~ x ~ n r ~ 

To reposition these windows: 

+ Place the arrow cursor in the gray space in the upper right comer of the 
window or, in the case of the Palettes window, to the left of the window, 
press the mouse, and drag the window where you want it. 
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Font Table Window 

You can move characters from the Palettes rre1U into the Palettes window, 
making them easier to reach. To do this: 

+ With the Palettes window open, pull down the Palettes menu to Operators 
and release the mouse. This places that line of characters in the Palettes 
window. To remove Operators from the Palettes window, pull down the 
Palettes menu and release the mouse. 

To remove these windows from the screen, click in the small white box in 
the upper left corner of each window. 

A fourth floating window, the Font Table window, can be placed on the 
screen in the same way; however, since this is a large window, you may 
want to open it only when you need it rather than placing it on the screen. 
Click en the re-size box at bottom right comer of the Font Table Window 
and drag to make the window smaller. This window has a pop-up irenu 
that lets you select among several different fonts. Each font contains a 
variety of symbols as well as numbers and letters. 

+ Press and drag the mouse on the font name in the upper left comer to open 
the pop-up menu shown on the following font table . 

.... 
1 

Mon.ace 

N Helvetica Narrow Tl:~llUI EJ 

• N•w C•ntury Schlbk 

New York i.. e t 00 (. - * c 0 
P.alatino 

~ e • :!: i . 6 -
Symbol 

mt i ~ s " v ..... 
I 

"'venice i £ ~ v M (J 
M 

Zapf Chancery J i § ¥ f • o/o~ v 
J u 'ro ~ r.; u e u 0 i: • µ = I ;... l 

D D & 6 F v f v u ii en a D. + t . 
D D I 7 G w g w a. 6 13 L. « 0 ;,. -
D D ( 8 H x h x a. 0 ® n )) 9 E -

D ) 9 I y i 'I a 0 © n y i:: ¥ ... 
D D • : J z j z a o™ f I i 
D D + ; K [ k { i i5 

. 
~ A. a i . 

D D < L \ I I l ii - I A. < i I • 
D - = M ] m } ~ u ~ n 0 > i .. 

D D > N II n - e u IE a:l CE fi 6 . 
D D I ? 0 0 D e u 0 II! c:e ft 6 . 

0 -
~ ~ 12.J 



Writing a Paper With MathWriter 39 

Auto Math and Auto Math Options ... 

Diac 

1. Pull down the Style menu to Auto Math Options ... and release the mouse. 
That opens the following window. 

Ruto Moth Options .•• 
(Auoiloble Only With Auto Moth Turned On) 

x~ 0 D Auto-Spocing Around Operators 

X......: B [8'.I Auto-Brocket Sizing 

X......: I D Auto-ltoliclze 

X......: G D I tulit:i:Z<~ Gnrnk Ct1<1r<H tNs 

- Use Symbol Font For Keyboord 
x~ S IVI 

i= Generated Operators And Brackets 

2. Click the boxes beside those options you want to activate. Auto-spacing 
around operators automatically places a space around such things as a plus 
or a minus sign. Auto-bracket sizing automatically stretches brackets to fit 
an equation. Auto-italicize automatically italicizes the variables in 
equations without italicizing the constants and the functions. Use Symbol 
font for keyboard generated operators automatically replaces such things 
as a plus sign from one font with a plus sign from the better-formed Symbol 
font. 

3. Click OK to accept your choices or Cancel to reject them. Now you have 
chosen the Auto Math options you want, but you have to click Auto Math to 
enable the options you selected. 

4. Click Auto Math. 

5. Re-select Auto Math to disable it when you are not entering or editing an 
equation. 

This menu of diacriticals remains dimmed until you place the rursor 
immediately to the right of an alphabetical character. Then the top row 
becomes available. The name of the diacritic on which the cursor rests 
appears in the row at the bottom of the window. 

1. Place the blinking insertion point immediately to the right of an 
alphabetical character. 
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Typing an equation 

2. Pull down the Diac menu which looks similar to the following: 

- 0 # Ill _..._,..........., ...--. -•··• ........... . •··• ........... . ....._....t....,___J, __ J-

Hil-i~ ~ 
Ra ise KR 
Lower XL 
Remoue 
umlaut or di•resis 

3. Click the diacritical you want. 

4. Click the Raise and Lower rommands to adjust the height of the 
diacritical. 

5. Click Remove to remove the diacritic. 

6. Highlight or select a group of characters to enable the remaining 
diacritics. Math Writer automatically stretches the overbars, underbars, 
and grouping brackets. 

7. Click the split I-beam on the Tools Window to edit within these 
structures. 

8. Select or highlight one of these structures before using the Raise, Lower, 
and Remove commands. 

To illustrate how to type an equation, let's use the quadratic equation. 

1. Make sure your text is left justified. If it is, the left justified arrow I.._! in 
the Paragraph alignment box is highlighted. If not, click on that arrow. 

2. Drag a center tab • from the Tab well to the three inch mark on the ruler 
and tab to it. 

3. Type "x." 

4. Click the split I beam cursor[!.:] in the Tools window and then the ~ 
arrow in the Tools window. This places a tiny triangle, the equation 
insertion point, at the lower right of the x, ready for inserting the subscript. 
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5. Type the subscript: "1,2". Notice the subscript font is smaller than the x. 
Your equation now looks like this: 

6. Press enter to return to the main line of text and press space bar. If you 
accidentally press return rather than enter, press the option key to 
reposition the insertion point within the mathematical structure. 

7. Click "=" from the Operators line in the Palettes window and press space 
bar. 

8. Press on the fraction icon at the top of the Templates window j1 I 
and drag the irouse to the first fraction template of the pop-out 
menu and release. 

Xl,2 = -

9. Click "-" in the Operators line in the Palettes window. The minus 
character from the Operators line looks better than a hyphen. Press space 
bar, type ''b", and press space bar again. Notice that the fraction bar grows 
automatically as you enter characters. 

-b 
X1,i=-

JO. Click "±" in the Operators line in the Palettes window and press space 
bar. 

-b± 
X1,i=--

11. Press the square root icon in the Templates window, drag to the first 
square root symbol on the pop-out menu, and release the mouse. 

Xl,2 :: 
-b±v' 

12. Type the letter ''b". The square root template grows as you type. 

X1,2= 
-b±Vb 
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Numbering an equation 

13. Oick the 0 arrow on the Tools window to position the insertion point 
for the superscript. 

14. Type "2". Notice that the superscript font automatically appears 
smaller than the b. 

Xt,2 = 
-b±ytF 

15. Press enter to leave the superscript level. 

16. Click "-" from the floating Palettes window and type "4 a c," pressing 
the space bar between each symbol. The square root and fraction symbols 
continue to grow automatically. 

X1,2= 
-b±y"t?--4ac 

17. Press enter twice, once to exit the square root template and once to exit 
the numerator and move to the denominator of the fraction template. 

18. Enter "2 a", pressing space bar between the "2" and "a". 

-b±y"t?- -4ac 
X1,2= 

2a 

19. Press enter. Your equation is complete, but it does not have an equation 
number. 

MathWriter lets you number equations easily and keeps up with the 
sequencing for you. To give this quadratic equation the number "[1]": 

1. Place a left justify tab ._ on the ruler at the five inch mark or wherever 
you want the equation number. 

2. Place the blinking insertion point at the end of the equation. 

3. Press tab to move the cursor to the place you want the equation number. 

4. Pull down the Palettes rrcnu to equation # ~ and release the mouse. 
Math Writer then inserts "[1]" into your document. After you type the second 

equation, tab to the five inch mark, click on equation #~in the Palettes 
menu, and Math Writer inserts "[2]" after the second equation at the five 
inch mark. 
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Equation reference numbers 

MathWriter lets you assign reference numbers to equations in the text. To 
assign an equation reference number: 

1. Type '1 want to refer to equation". 

2. Press space bar. 

3. Pull down the Palettes menu to Variables and select equation reference~ 
from the Variables row. The following window opens. 

Type an equ;;ition number th;;it this reference points to 
~~~ or type a relative number: 
I.! I ' <', or '<n' =previous or previous nth 

'>" , or '>n' =next or ntxt nth 
or click on an equation number in the document. 

( C:Hncel OK 

4. Type "1" in the highlighted box in that window. 

5. Click OK. 

6. MathWriter inserts "[1]" into your text after the word "equation" and 
establishes a linkage between the equation number and its text reference. If 
you put another equation in front of equation (1), equation (1) would become 
equation (2) and its text reference also would change to (2). 

Correcting an error in a mathematical expression 

Creating a table 

Let's introduce an error into the quadratic equation and correct it. 

1. Click on the split I-beam math editor Qin the Tools window. 

2. Highlight or select the subscript "2" in x1,.2. 

3. Type "3", making the expression read x1,3. 

4. Highlight it again and type "2" to return the expression to its correct form. 

To create a table: 

1. Place the blinking insertion point in your text at the place where you want 
a table. You can use any of the templates in the last row of the Template 
window to create tables. 
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2. Select the last template ~on the last row in the Template window. 
That places a box in your document containing a flashing dot. I_•_] 

3. Type •1 • and press return lo create a new row. ~ 

4. Type "2" and press tab to create a new column. 

5. Continue typing the contents of the table, pressing return to create a new row 
and tab to create a new column. 

6. Click on the split I-beam Win the Tools window to edit within a cell in 
the table. 
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